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  epubreader's EPUBReader

  


  (next: Contents


  Contents


  Foreword


  About HTML


  My Workflow for No-Frills-Sigil-Epubs


  In calibre


  In sigil


  Making Chapters


  DEF1 - 1, 2, 3, ...



  DEF2 - Chapter 1, Chapter 2, Chapter 3, ...



  DEF3 - CHAPTER 1, CHAPTER 2, CHAPTER 3, ...



  DEF4 - One, Two, Three, ...



  DEF5 - ONE, TWO, THREE, ...



  DEF6 - I, II, III, ...



  DEF7 - Small images



  DEF8 - Description



  Some Tips


  Addenda

  


  (next: Foreword)


  Foreword


  I'm not an expert in book formatting. Just somebody who likes to read books. I'm also a minimalist: less is better.


  That's why i began looking for a simple method to change sloppy or extensively formatted ebooks into clean formatted books, that don't distract while reading.


  I knew i had to do it with sigil.


  The following is the result of learning, doing, learning...


  Maybe it can help somebody else, who hasn't much time to find out for her/himself.


  Oh, before i forget, i love Ubuntu.


  Oh, before i forget, my native tongue is Dutch.


  -webe

  


  (next: About HTML)


  About HTML


  For working with sigil you need to know a minimum of HTML,


  because an epub is just a renamed zip-file of one of more html-files (and some).


  In the Book Browser at the left you see the html's, here called Sections.


  In Code View you can view the html-code of every single Section.


  What are the components of this html-code?

  


  THE HEADING: is the same for every Section of the book. Note: Leave it as it is!


  ... <?xml version="1.0"?>


  ... <!DOCTYPE html PUBLIC "-//W3C//DTD XHTML 1.1//EN"


  ... "http://www.w3.org/TR/xhtml11/DTD/xhtml11.dtd">


  ... <html >


  ... <head>


  ... <title></title>


  ... </head>

  


  THE BODY: contains all the paragraphs you're going to read on your reader.


  All paragraphs stand between the tags <body> and </body>

  


  THE PARAGRAPHS


  Text is contained in paragraphs and is placed between the tags <p> and </p>

  


  That's all you need to know about html to understand what follows.


  Where are the Chapters?


  At the left, in the Book Browser, you see one or more Sections.


  The order is important: the uppermost comes first on your reader, the second comes next, etc.


  You can change this order by dragging up or down.


  The start of a new Section is also the start of a new page (page-break) on your reader!


  So, if a Section contains only one chapter, then every chapter will start on a new page on your reader.

  


  (next: Workflow)


  Workflow


  In CALIBRE


  .... 1. open e-book(s)


  .... 2. convert to TXT format


  .... 3. save to disk TXT only format


  .... 4. delete book(s)


  .... 5. quit calibre


  In SIGIL


  .... 6. open TXT file in sigil


  .... 7. save as sigil-epub


  .... 8. change to CODE VIEW


  .... 9. insert book data in meta-editor


  ... 10. clean up: remove all unwanted text and extra's


  ... 11. save


  ... 12. make chapters


  ... 13. save


  ... 14. check for errors


  ... 13. quit sigil


  In FIREFOX


  ... 14. open in FF with EPUBReader


  ... 15. view and check


  In CALIBRE (optional)


  ... 16. convert sigil-epub to other ebook-format

  


  (next: In CALIBRE)


  In CALIBRE


  Follow these instructions before you start making chapters.


  ... Open calibre


  ... Create an empty library in calibre


  ... Open the e-book(s)


  ... Convert to TXT with the default settings for TXT Output


  ... Save to disk > Save single format to disk...


  ... Choose TXT


  ... Choose directory


  ... Remove books > OK


  ... Quit calibre

  


  (next: In SIGIL)


  In SIGIL


  Follow these instructions before you start making chapters.


  Open and save the TXT-file in sigil:


  ... Sigil opens in BOOK VIEW


  ... Save TXT file as a sigil-epub in the directory of your choice


  ... My choice is a directory called "sigil-epubs"


  ... I name them all as "Title (sigil)-CH.epub", where "(sigil)-CH" reminds me that they are CHapterized Sigil-epubs.


  Change to CODE VIEW


  Insert book data in meta-editor:


  ... Select the title-name (between the p-tags)


  ... Copy (Ctrl-C)


  ... Open the Meta Editor (F8)


  ... Paste (Ctrl-V)


  ... OK (Enter)


  ... Select the author-name (between the p-tags)


  ... Ctrl-C


  ... F8


  ... TAB


  ... Ctrl-V


  ... Enter


  ... Save


  Clean up:


  ... remove manually all text, that you don't want in your book (publisher's text, table of contents, etc.)


  ... remove by Find & Replace all extra's, that you don't want in your book, like


  ...... <p><br /></p> (extra blank line between paragraphs)


  ...... <p>***<p> (asterixes)


  Save


  Exit sigil

  


  (next: Making Chapters)


  Making Chapters


  After re-opening the sigil-epub, there is only one Section in the Book Browser, the complete undivided text of the book.


  Sigil opens in BOOK VIEW, so you can now easily see how the chapters in this book are defined.


  



  The various chapter DEFinitions i have encountered sofar:


  



  DEF1 - 1, 2, 3, 4, 5, ...



  DEF2 - Chapter 1, Chapter 2, Chapter 3, Chapter 4, Chapter 5, ...


  DEF3 - CHAPTER 1, CHAPTER 2, CHAPTER 3, CHAPTER 4, CHAPTER 5, ...


  DEF4 - One, Two, Three, Four, Five, ...


  DEF5 - ONE, TWO, THREE, FOUR, FIVE, ...


  DEF6 - I, II, III, IV, V, ...


  DEF7 - Small images


  DEF8 - Description


  



  In the next chapters I will explain my methods of chapterizing books with a specific DEF.

  


  (next: DEF1)


  DEF1


  



  In BOOK VIEW: 1, 2, 3 ...


  In CODE VIEW: <p>1</p>, <p>2</p>, <p>3</p>, ...


  



  Three methods to make chapters:


  



  1.


  In BOOK VIEW


  Put your cursor behind the last sentence of what's gonna be your start-page.


  Choose: Insert > Chapter Break. I find it easier to use the shortcut keys: Ctrl+Return.


  Result: your first chapter.


  You are now in the rest of the epub. At the top stands: 1


  Use the PageDown-key to go through the text, till you see the number 2


  Repeat the above actions untill you have reached the end of the file.


  Note: at the end of the file, now the last chapter, i look again for text i don't want in my book. And remove it.


  



  2.


  In CODE VIEW


  Put your cursor behind the closing p-tag (</p>) of the last paragraph of what's gonna be your start-page.


  Make a chapter-break with Ctrl+Return.


  Then, open the Find & Replace Dialog with Edit > Find, or simply with Ctrl+F


  Type after Find what: <p>?</p>


  The question mark is the wildcard for one character, in this example you will find:


  <p>1</p>, <p>2</p>, <p>3</p> ... <p>9</p>


  Watch it! Everytime you use the Find & Replace Dialog check the correct 'Search Mode.'


  In this example it must be 'Wildcard'.


  Click on the Find Next button, and <p>2</p> appears, clothed in green.


  Put your cursor behind the closing p-tag (</p>) of the last paragraph of chapter 1, and make a chapter-break with Ctrl+Return.


  And so on, till you get the message "The search term cannot be found."


  Add an extra question mark in the search term, like this <p>??</p>, and hit Find Next - there is the begin of chapter 10!


  



  3.


  In CODE VIEW


  Replace all numbers by a so-called SGF Chapter Marker


  This one works very fast.


  Open the Find & Replace Dialog with Ctrl+H


  Put the Search Mode in Wildcard mode


  Type after Find what: <p>?</p>


  Type after Replace with: <hr class="sigilChapterBreak" />


  Hit the Replace All button


  Do the same for <p>??</p>


  Hit F6 (Tools > Split On SGF Chapter Markers)


  The complete TXT-file is now splitted in chapters.


  



  BUT, the chapters have no numbers. Well, that's easy done.


  Close sigil and re-open the epub. Why?


  All new opened chapters will be in BOOK VIEW, and that is what we'll need


  Open the first chapter by Double-Clicking the correct Section


  Put your cursor in front of the first sentence


  Type 1 and hit Return


  Double Click the next Section (the second chapter)


  Type 2 and hit Return


  And so on

  


  (next: DEF2&3)


  DEF2 & DEF3


  



  In BOOK VIEW: Chapter 1, Chapter 2, Chapter 3, ...


  In CODE VIEW: <p>Chapter 1</p>, <p>Chapter 2</p>, <p>Chapter 3</p>, ...


  or


  In BOOK VIEW: CHAPTER 1, CHAPTER 2, CHAPTER 3, ...


  In CODE VIEW: <p>CHAPTER 1</p>, <p>CHAPTER 2</p>, <p>CHAPTER 3</p>, ...



  



  In CODE VIEW


  We'll split the Section in chapters by placing a Sigil Chapter Marker before the finds of 'Chapter' (or 'CHAPTER')


  Open the Find & Replace Dialog


  Find what: <p>Chapter


  Replace with: <hr class="sigilChapterBreak" /><p>Chapter


  or


  Find what: <p>CHAPTER


  Replace with: <hr class="sigilChapterBreak" /><p>CHAPTER


  Search mode: Normal


  Hit Replace All


  F6


  The Section is splitted in Sections, which are now also chapters with the same DEF


  note: the Sigil Chapter Markers disappear after F6

  


  (next: DEF4)


  DEF4


  



  In BOOK VIEW: ONE, TWO, THREE, ...


  In CODE VIEW: <p>ONE</p>, <p>TWO</p>, <p>THREE</p>, ...



  



  In this method we're gonna use the Regular Expression mode.


  In some cases the Normal and Wildcard modes won't work. So, we have to try it, don't we?


  Ever been at the eye-doctor's? "Will you please read the following..."


  Regular Expression mode is like that for me.


  With a Regular Expression you give sigil a command to start reading from the upper-left in your file and check for a match.


  Found a match? Yes !, stop and show me. No match? continue scanning to the right. Found a match? Yes!, stop and show me. Continue please. No match? go on.... Still no match at the end? Continue at the start of the next line. And so on untill sigil has found and showed all matches.


  The Regular Expression aka command we give sigil here is:



  Find <p>[A-Z]*</p>



  Find a '<', AND find a 'p' next and behind it AND find a '>' AND find 'any uppercase character from A to Z' AND find 'none or more uppercase characters' behind it AND find a '<' AND find a 'p' AND find a '>'


  Sigil will stop at <p>ONE</p> ... first match found!


  After a Ctrl+H, i let sigil continue scanning my epub.


  The next match it finds and where it again stops searching is: <p>TWO</p>


  I hope this makes any sense to you, and is more or less acceptable for the RE-guru's.



  



  Note: you can always follow the visual method of searching in BOOK VIEW.


  Where that will bring you? "Will you please read the following...". Yes, there!


  



  In CODE VIEW



  Search for all occurrences of these chapter-names:


  Find what: <p>[A-Z]*</p>


  Regular Expression mode


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Hit the Find Next button


  Etc.


  NOTE: see Addenda (2) for a more sophisticated way

  


  (next: DEF5)


  DEF5


  



  In BOOK VIEW: One, Two, Three, ...


  In CODE VIEW: <p>One</p>, <p>Two</p>, <p>Three</p>, ...



  



  For these definition you can use the same approach as outlined in the previous one, with one catch:


  For One, Two, Three ... Twenty, Thirty, Forty, etc. it works great.


  For the In-Betweens not at all. For these I had to find the right Regular Expression.


  



  My solution, with Regular Expression mode checked:


  ... for the first twenty chapters: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Thirty: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Forty: <p>[A-Z][a-z]*</p>


  ... for the next nine chapters: <p>[A-Z][a-z]*[-][a-z]*</p>


  ... for chapter Fifty: <p>[A-Z][a-z]*</p>


  ... etc.


  



  Note: sounds rather complicated, but works well. You can easily change the search term in the Find & Replace Dialog, because sigil remembers the last 20.


  HOWEVER, if you find it too complicated, you can always fall back on the method of looking and finding in BOOK VIEW.


  



  Comment: This works for me, i found the solution for the catch by trial and error. As i said before, i still have minimal knowledge and experience with Regular Expressions.


  Note: see Addenda 2

  


  (next: DEF6)


  DEF6


  



  In BOOK VIEW: I, II, III, ...


  In CODE VIEW: <p>I</p>, <p>II</p>, <p>III</p>,



  



  In CODE VIEW


  Search in the Find & Replace Dialog for all occurrences of the chapter-names:


  Find what: <p>[A-Z]*</p>


  Regular Expression mode


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Hit the Find Next button


  Make a Chapter Break with Ctrl+Enter


  Etc.


  Note: this is the same method as for ONE, TWO, THREE, etc .! (DEF4)

  


  (next: DEF7)


  DEF7


  Images as chapter definition


  



  Some books use (small) images as a definition of the start of a (new) chapter. These books ask for a somewhat different approach, because after converting them in calibre to a TXT file, all images are gone.


  



  Open the original with Firefox: EPUBReader will show the images. So, you can easily determine where all the chapters start.


  In sigil change to CODE VIEW



  Go to FF


  Copy the beginning of the sentence under the image (select with cursor, Right Click, copy)


  Go to sigil


  Ctrl+F


  Paste behind Find what:


  Find Next will bring you to the start of the next chapter.


  Ctrl+H


  And so on for the rest of the chapters.



  



  How to add your own chapter-names? See method 3, at the end of DEF1

  


  (next: DEF8)


  DEF8


  In BOOK VIEW: Description, Description, Description, ...


  In CODE VIEW: <p>Description</p>, <p>Description</p>, <p>Description</p>, ...


  



  This DEF you'll find in books with short stories or books with chapters that start with a description of or a hint at their content.


  To make chapters yo may follow the method of scrolling in BOOK VIEW and Ctrl+Enter.


  Another way would be the Copy & Paste method with the EPUBReader of Firefox (see DEF7, images). Better for your eyes!

  


  (next: Some Tips)


  Some Tips

  


  1. Watch your cursor! Make sure it is at the right place, before you let sigil do it's thing!


  


  2. Use the keyboard Shortcut Keys of sigil, as often as possible!

  


  3. Use the Firefox Add-on EPUBReader


  I make extensive use of the Firefox Add-on EPUBReader. With it you can open the original epub - if you have one - for a first view, the TXT file from calibre, the consecutive versions of the sigil-epub.


  With FF EPUBReader in the background you can easily test the results of all your editing in sigil.


  Note 1: Refresh DOES work. You have to activate the other TAB, then hit Refresh.


  Note 2: Selecting in FF in EPUBReader. Watch out for selecting one or more spaces at the beginning of a line. 'Find what:' won't find nothing!

  


  4. When using the Regular Expression method i always check the Regex at least once.


  If the result is o.k., i Undo before using it on the complete ebook. That way i don't get an empty section i have to remove by hand.


  And, i always check the end of the ebook. Sometimes you find there a list of chapters. You get a lot of empty sections after Replacing, if you didn't remove them.

  


  5. The Case of the Broken Paragraphs


  Well, the name says it all: in some books i found split-sentences that should be in the same paragraph. A lot of them.


  Viewing and searching for them in BOOK VIEW was a no-no for me.


  So i tried finding them automatically in sigil. I had to use the Regular Expressions mode again (sigh). I found a way to do it.


  In CODE VIEW


  Find what: <p>[a-z]


  This finds all paragraphs beginning with a lowercase character.


  Select with your cursor from before the closing tag (</p>) to behind the open tag (<p>).


  Like this:


  <p>---------------------------------x</p>



  <p>x-------------------------------</p>


  (x stands for the start- and end-position of your cursor)


  Hit the space bar



  Done


  And then, the next 10, 20, 30?


  Case solved and closed or are there any loose ends left?


  Edit: yes! See ADDENDA

  


  6. Look in "Look in:"


  In the Find & Replace Dialog you must always check for the correct Search mode.


  BUT also what comes after Look in: 'Current File' or 'All HTML files'.


  Suppose you're searching for something and get the "The search term cannot be found." message.


  What will be correct only for the Current File, if that's in 'Look in:'.


  Change "Current File" into "All HTML files" and maybe you do find (more) occurrences of your search term.

  


  7.

  


  (Next: Addenda)


  



  Addenda

  


  



  1. Replacing 1, 2, 3, ... 10, 11, 12 ...etc. (DEF1) (continued)



  



  The wildcard method isn't always secure: every occurrence of any character(s) between <p> and </p> are replaced!


  The Regular Expression method is more secure.


  In Code View


  Search mode: Regular expression



  Find what: (<p>[0-9]+</p>)


  Replace with:<hr class="sigilChapterBreak" />\1


  Replace All


  



  INFO 1



  [0-9] means: one of the digits between 0 and 9


  + means: at least once [0-9], but can be more times


  (<p>[0-9]+</p>) means: remember the match of <p>[0-9]+</p>


  <hr class="sigilChapterBreak" /> means: well, you know, the sigil ChapterBreak



  \1 means: replace with the remembered match of <p>[0-9]+</p>


  



  INFO 2


  The metacharacter? matches 0 or 1 of the preceding element



  The metacharacter*matches 0 or more of the preceding element


  The metacharacter +matches 1 or more of the preceding element



  With tools that support backreferencing, parentheses "remember" the text that the subexpression inside them matches, and the special metasequence \1 represents that text later in the regular expression, whatever it happens to be at the time.


  From: O'Reilly - Mastering Regular Expressions; 1.4.10. Parentheses and Backreferences

  


  



  2. Replacing I, II, III, IV, V... etc. (DEF6) (continued)


  



  In Code View



  Search mode: Regular expression



  Find what: (<p>[A-Z]+</p>)



  Replace with:\1


  Replace All

  


  



  3. When the book is also divided in parts, e.g. PART ONE, PART TWO, etc.


  



  FIRST make the division in chapters in wildcard- or regular expression mode,


  THEN make the division in parts, manually.


  It helps opening the book in FF to find the chapters after which a new part starts.


  You'll find the place at the end of them, where you can make a Chapter Break.

  


  



  4. Splitting off of a word in lower case from preceding words in uppercase


  



  At the beginning of a paragraph are one of morewords in uppercase.



  The first word in lower case follows without a space.


  In Code View


  Search mode: Regular expression


  Find what:[A-Z]+[a-z]


  Find Next


  Correct manually by inserting a space

  


  



  5. The Case of the Broken Paragraphs (continued)


  



  Code View


  Regular Expression


  Find what:</p>\s<p>([a-z])


  Replace with: \1 (i.e. one space followed by \1)


  Find Next


  Check:


  OK? than Replace


  not OK?, than Find Next


  etc.



  Note:Pay attention where you put the parentheses


  



  See also:


  http://www.mobileread.com/forums/showthread.php?t=147485


  for the guru-solution:


  ([^.”:?'!>—’)])</p>\s+<p[^>]*>


  



  INFO


  How i read this guru-Regex?


  



  The first part of the Regex:([^.”:?'!>—’)])


  Find a match of the character directly before </p> that's NOT . OR ” OR : OR ? OR ' OR ! Or > OR — OR ’ OR )


  The parentheses say: and remember that character!


  Between the first and second square bracket, the ^ (caret) at the beginning negates all the following characters.


  



  The second part of the Regex:</p>\s+<p[^>]*>


  Find also < AND / AND p AND > AND one or more spaces AND < AND p AND [^>]* AND >


  \s+ is shorthand for one or more spaces


  [^>]*Find a character that is NOT >


  The star (in regex-talk) says that [^>] may be not matched or once, twice, thrice, etc.


  



  If i do read it right, than the [^>]-part is a bit overdone for no-frills-epubs.


  In these every paragraph starts with <p> (no-frills n'est-ce pas?)


  That's why i used</p>\s+<p>([a-z]) in The Case of the Broken Paragraphs (see above).


  Note: do as "theducks", don't forget to check 'Match case' under Options in the Dialog



  



  There's another point of concern.


  With the slightly changed guru-solution,


  ([^.”:?'!>—’)])</p>\s+<p>[a-z],


  i get less matches than i want.


  e.g.: in books where paragraphs are broken after a colon (:)


  Or more matches:


  e.g.: in the case of broken paragraphs ending with a '-', like in


  ... sub-</p>


  <p>stitution ....


  



  Well, know your text, as they say in Regex-land.


  


  


  



  6. When there is no DEF at all ... (DEF0)



  



  Open thecalibre txt-file in sigil


  Open the calibre txt-file in FF


  Search for the first block of empty lines


  Select several words at the beginning of the next line


  Tip: Click the start of the line, presss and hold the shift-key, put the cursor to the right somewhere and click


  Copy


  Change to sigil


  Ctrl-F


  Paste after Find what:


  Hit Return


  Make a chapter-break


  Change to FF, ... etc.


  A lot of work!

  


  (Next: Addenda (2))


  Addenda (2)

  


  7. DEF4: ONE, TWO, THREE, ... TWENTY, TWENTY-ONE, TWENTY-TWO, etc


  The problem: how to find and replace all chapter numbers with one regex.


  In CODE VIEW


  Find what: (<p>[A-Z]+-?[A-Z]*</p>)


  Replace with: <hr class="sigilChapterBreak" />\1


  How to read this regex:


  () remember the match of the regex between the parentheses


  [A-Z]+ find one or more characters in uppercase


  -? find zero or one hyphen


  [A-Z]* find zero or more characters in uppercase

  


  8. DEF5: One, Two, Three, ... Twenty, Twenty-One, Twenty-Two, etc.



  In CODE VIEW



  Find what: (<p>[A-Z][a-z]+-?[A-Z]*[a-z]*</p>)



  Replace with: <hr class="sigilChapterBreak" />\1

  


  9. Separate text in blocks for readability with <hr /> (horizontal line)



  Recurring "How it Works" in Andrew Watt's Beginning Regular Expressions



  In Code View


  Search mode: Regular expression


  All HTML Files


  Find what: (<p>How it Works</p>)



  Replace with: <hr />\1


  The manual way:



  In Book View


  Insert SGF Chapter Markers (Ctrl+Shift+Return)


  After inserting them all ...


  RED ALERT: DON'T PRESS F6



  Change to Code View


  Search Mode: Normal


  All HTML Files


  Find what: <hr class="sigilChapterBreak" />


  Replace with: <hr />

  


  (Next: Addenda (3))



  



  Addenda (3)


  
    Although i've learned something about regular expressions - see the first reports of my ramblings in Regex Land - i'm still uncertain about how to find my way.


    So i went back to the beginning, to answer the question: WHAT'S THIS ALL ABOUT?


    How? By reading the first chapter of a couple of books, where the author tries to explain to me the fundamentals of regular expressions.


    Here i report the results of this "close reading".


    


  

  


  PART ONE: An expression of what?

  


  What to think of the following quotes from the book "sed & awk by Dale Dougherty & Arnold Robbins"?


  1. "An expression is not something to be interpreted literally. It is something that needs to be evaluated."


  2. "Novice users are inclined to think in higher-level units such as words, and not individual characters."


  3. "Concatenation is the basic operation implied in every regular expression. That is, a pattern matches adjacent characters."


  4. "A regular expression describes a pattern or sequence of characters."


  5. "To understand regular expression syntax, you have to learn the functions performed by various metacharacters."

  


  ad 1. "An expression is not something to be interpreted literally. It is something that needs to be evaluated."


  Question: What does the word expression mean?


  Expression: a representation of something by symbols; idiom


  Symbols: i think of the balloons in comix with 'exclamations' in them in stead of 'regular' text and how i evaluate, interpret them


  Idiom: "Someone let the cat out of the bag" mustn't be taken literallly, but needs evaluation to understand the meaning of it.

  


  ad 2. "Novice users are inclined to think in higher-level units such as words, and not individual characters."


  Question: What is a book?


  Consecutive characters make a word.


  Consecutive words make a sentence.


  Consecutive sentences make a paragraph.


  Consecutive paragraphs make a chapter.


  Consecutive chapters make a book.


  conclusion:


  For the regular expression engine in sigil a book consists of a stream of individual characters.

  


  ad 3. "Concatenation is the basic operation implied in every regular expression."


  What is concatenation? A sort of 'glueing' together a character to the previous one.


  For example: in ABC "B" is glued to "A" and "C" is glued to "B".


  What does it mean in this context?


  For a regex engine all characters are glued together, one after the other (consecutive) and the next one to the previous one (adjacent)


  conclusion:


  For the regular expression engine in sigil a book consists of lines of concatenated (consecutive and adjacent) individual characters.


  This is in my opinion one of the most important principles to understand 'What's this all about.'

  


  ad 4. "A regular expression describes a pattern or sequence of characters."


  What do we need? Well, first of all a stream editor to let the stream of consecutive, concatenated characters, the text of the book, flow through.


  The alternative, changing the text with an editor interactively, i.e. one change at a time, is most of the time a no-no.


  Next we concoct an instrument that can find, during the flow through the stream editor, only one character or two or more consecutive and adjacent characters of our choice and act upon them.


  Let's call that instrument a character grabber, or ... as most people in this business do ... a regex.


  The instrument is a sort of sieve, a filter. It keeps something from the flow, marks it, and then we can do something with it, change it, replace it.


  Which specific part of the concatenation of characters do we want to sieve, to filter out of the stream?


  How do we describe that specific part of the concatenation of characters we're after?


  That description could be named a pattern, a pattern of consecutive, concatenated characters, a regex-pattern.


  The instrument filters the flow with that specific pattern, keeps the so-called matches in the sieve, marks them, and let the other ones, that don't fit the pattern, pass.


  How to make such a sieve a.k.a. regex-pattern?


  For us, sigil-users, it's only the regex-pattern we must describe. The stream-editor is built-in, the regular expression engine, too.


  Writing a sentence presupposes knowledge of the rules about how to compose it. If so, the result is readable text for human beings.


  Likewise, writing a regular expression presupposes knowledge of the rules about composing it. If so, the result is a regex-pattern.


  



  conclusions:


  1. A regex-pattern is readable by the regex engine, if i followed the rules, a.k.a. the syntax, of writing regexes.


  2. I can read a regex-pattern, written by myself or somebody else, only if i know the syntax for writing regexes.


  3. For writing regular expressions i have to learn the syntax; it's unavoidable ... period.

  


  ad 5. "To understand regular expression syntax, you have to learn the functions performed by various metacharacters."


  What are these functions? What DO these metacharacters?


  Well, sometimes "a character is a character is a character ..." Then a character is just itself, nothing more, nothing less. Evaluate me literally, please.


  But, "not all characters are equal, some are more equal than others." Evaluate me not literally, but as a symbol for a specific function, please.


  Here they come, the special characters, a.k.a. the meta-characters, the "i-do-more-than-just-being-myself" ones.


  They get a special meaning inside a special context: that is, when used in a regular expression.


  Characters that do nothing more than being itself are called literal.


  The second category: special characters or meta-characters.


  



  conclusions:


  Most characters do nothing special in the context of a regular expression, they are just... characters


  Some characters, the so-called meta-characters, are special, because they DO something, they perform a funtion in the context of a regular expression.


  That's why learning the functions of the meta-characters is necessary for what i want to DO with my text

  


  conclusion of PART ONE:


  My regular expressions must be expressions of what i want to DO with my text and must conform to the rules for writing them, a.k.a. the syntax.


  


  


  PART TWO: What's this all about? It's all about syntax. (see note at the bottom)


  


  Syntax: a general definition



   "Rules and conventions regulating the order and relationships of words in a sentence."


  Syntax: specific for regexes


   "Rules and conventions regulating the order and relationships of characters in a regex-pattern."


  What are the relations of literal and special characters in a regex-pattern?


  Where do i put the literal characters, and where the special characters a.k.a the DO-characters?


  What do i want to DO with my text?


  Which meta-characters do i need to achieve that goal?


  How do i put them in my regex together with the literal characters?


  These questions are questions about the syntax.


  For this quest i followed the content of the chapters about sed in the above mentioned book.


  Quotes:


  "Sed offers capabilities that seem a natural extension of interactive text editing. For instance, it offers a search-and-replace facility that can be applied globally to a single file or a group of files."


  "Sed goes through the file, a line at a time, such that each line becomes the current line, and the commands are applied to it. The result is that sed applies a command to every line in the file."


  "In sed, each instruction has two parts: a pattern and a procedure. The pattern is a regular expression. A procedure specifies one or more actions to be performed."


  "By default, all of the input to sed passes through and goes to standard output. The input file itself is not changed. When you are satisfied with the edits you've made, you can replace the original file with the modified version."


  sed is a stream editor. What i read sofar about its modus operandi, it looks like the way sigil asks for input in its Famous Find & Replace Dialog (FF&RD)


  I can't see into the innards of sigil, but it seems to me that it can do stream editing, like for example sed does.

  


  Stream editing with sigil


  Code View (important!)


  Input in the FF&RD:


  Search mode: Regular expression


  Find what: description of the regex-pattern


  Replace with: description of the replacement text


  Look in: stream the current section only or stream all sections


  Stream forwards or backwards or both


  Match case, or not


  Greedy or minimal matching?


  Replace All or Find Next and Replace


  Overwrite the old section(s) with the new changed section(s)


  



  conclusions:


  1. sed is a line-oriented stream editor


  2. sed accepts a regular expression as a pattern, and find & replace as actions


  3. sed doesn't change the file by itself, you must do that yourself


  4. sigil works like a stream editor, comparable to the way sed does, in code view


  5. For us, sigil-users, the capabilty of a stream editor to find & replace with regex-patterns is the most important one.

  


  Intermezzo: Line-oriented stream editing


  What is a line in an epub?


  Epubs are zip-files.


  Open one with a unzip program


  Look in the directory OEBPS


  Look in the sub-directory Text: there are what sigil calls the sections (xhtml-pages)


  Extract one to the Desktop and open it with FF


  You're now in what in sigil is named: Book View


  View >> Page Source (Ctrl-U)


  You're now in what in sigil is named: Code View


  You can see that the text contains lines, short, longer and very long ones


  When you're viewing the Page Source, all lines start with <p> and end with </p>


  Does that mean that, what we call a paragraph in sigil, is a line as in line-oriented?


  In normal text a line has a start and an end. At the end there has to be some sort of end-of-line character(s): LF (in Unix) or LF+CR (in DOS, Windows)


  



  What tells w3schools.com us?


  a. XML Stores New Line as LF


  In Windows applications, a new line is normally stored as a pair of characters: carriage return (CR) and line feed (LF). In Unix applications, a new line is normally stored as an LF character. Macintosh applications also use an LF to store a new line.


  XML stores a new line as LF.


  b. White-space is Preserved in XML


  HTML truncates multiple white-space characters to one single white-space.


  With XML, the white-space in a document is not truncated.


  c. HTML Paragraphs


  Paragraphs are defined with the <p> tag


  Note: Browsers automatically add an empty line before and after a paragraph.


  d. HTML Line Breaks


  Use the <br /> tag if you want a line break (a new line) without starting a new paragraph.


  The <br /> element is an empty HTML element. It has no end tag.


  



  conclusion:


  Because the files in epubs are xhtml-files, the paragraph end-tag (</p>) is responsible for the end of a line and the beginning of a new line.


  That's why you have to work in Code View


  



  Note: Why is, why was this important?


  Because you can use the special characters '^' and '&' in a regex-pattern to say: i want the preceding characters to match, but only when they are at the beginning respectively at the end of the line.


  But, this didn't work in sigil, because the regex engine is a Qt's QregExp, that resembles the engine of Perl, but not in this respect.


  In the documentation of sigil:


  "The regular expression (regex) engine used in Sigil is very “Perl-like”. The current regex engine used is actually Qt’s QRegExp. It will eventually be replaced with PCRE because of the latter’s advanced features and performance."


  In the FF&RD pops up the following, when hovering the cursor above 'Regular Expression' under Search modes:


  Regular expression: Perl-like regular expressions with minor differences.


  



  conclusion:


  Searching for characters at the end of the line is only possible by using </p> in the regex-pattern.

  


  Back to the syntax.


  (As you will understand i'll focus on 'no-frills-epubs')


  Here are the regex-patterns i used so far for splitting a book-text in chapters


  <p>[A-Z]*</p>                   for "ONE, TWO, THREE, ..." (DEF4)


  (<p>[0-9]+</p>)                  for "1, 2, 3, ... 10, 11, 12 ...etc." (DEF1) (continued)


  (<p>[A-Z]+</p>)                  for "I, II, III, IV, V... etc." (DEF6) (continued)


  (<p>[A-Z]+-?[A-Z]*</p>)           for "ONE, TWO, THREE, ... TWENTY, TWENTY-ONE, TWENTY-TWO, etc" (DEF4) (continued)


  (<p>[A-Z][a-z]+-?[A-Z]*[a-z]*</p>)   for "One, Two, Three, ... Twenty, Twenty-One, Twenty-Two, etc." (DEF5)


  



  For doing other tasks


  [A-Z]+[a-z]                      for "Splitting off of a word in lower case from preceding words in uppercase"


  </p>\s<p>([a-z])                  for "The Case of the Broken Paragraphs (continued)"


  ([^.”:?'!>—’)])</p>\s+<p[^>]*>       for "The Case of the Broken Paragraphs (continued)" (guru-regex-pattern)


  



  Note: In the FF&RD of sigil you can use two other Search modes. 'Normal' for use without special characters, or 'Wildcard' by using the wild-cards ?, * and [...]


  I think it is correct to assume that the Regular expression Search mode is the most comprehensive. That's why i will use it in and for all cases.

  


  Overview of the meta-characters and their syntax


  Note: use in Code View!


  



  THE QUANTIFIERS



  The plus character: ' + '


  Its function is: makes the regex engine search the stream for and match the preceding adjacent character or class of characters - 1 or more times.


  Rule: put the + after a character or class of characters you want to find.


  The star character: ' * '


  Its function: makes the regex engine search the stream for and match the preceding adjacent character or character class - 0, 1 or more times


  Rule: put the * AFTER a character or class of characters you want to find.


  The question mark character: ' ? '


  Its function: makes the regex engine search the stream for and match the preceding adjacent character or character class - 0 or 1 time only


  Rule: put the ? AFTER a character or class of characters you want to find.


  



  THE CONSTRUCTS


  The square brackets construct: ' [...] '


  Writing a bunch of concatenated characters between the brackets makes them a so-called 'class of characters' (or 'range of characters')


  The function of this construct is: let the regex engine search for the first character between the brackets, and, when found, make a match, and stop there. If the first character is not found, then search for the second character, and so on (consecutive & adjacent !)


  In other words, it makes the regex engine search for one character only. Thus it is the first character OR the second adjacent character OR the third adjacent character... that are matched, or none is matched.


  There are shorthands for some classes of characters, like


  [a-z] search for a, b, c, ... z (all lowercase)


  [A-Z] search for A, B, C, ... Z (all uppercase)


  [0-9] search for the digit 1, 2, 3, ... 0 (all digits)


  or combinations of them between the brackets


  Rule: put the characters or the shorthand(s) you're searching for between square brackets


  



  The caret in the square brackets construct: ' [^...] '


  It's function: makes the regex engine search the stream for and match any character that's not the same as the following character or character class (called complementing)


  Rule: between the square brackets, BEFORE the characters


  



  The space construct ' \s '


  It's function: makes the regex engine search the stream for and match any space character


  Rule: you could put a space instead for finding a space. A space is a space is a space ...


  



  The parentheses construct: ' (...)


  It's function: makes the regex engine search the stream for and match 'something' and store the match in memory.


  This is handy when you want the match in the 'Replace by'-action. This is called: back-referencing.


  Furthermore, you can have more than one parentheses constructs in a regex-pattern.


  Remembering the matches of the consecutive parentheses constructs is done by putting /1, resp. /1 /2 /3 ... etc. in 'Replace with' of sigil's FF&RD


  The curly braces construct: ' {n} '


  It's function: makes the regex engine search the stream for and match the preceding adjacent character or character class n times.



  Rule: BEHIND the preceding character or character class


  



  I'm not giving any examples. Do as i do: open an epub in sigil, change to code view ... and TRY


  



  NOTE: for a complete and more systematic overview, written by regex-guru Jan Goyvaerts,


  see "Regular Expression Basic Syntax Reference" at http://www.regular-expressions.info/reference.html.

  

  

